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Welcome to another issue of EON
and a belated happy New Year to
all! 2014 is already in full swing
and we’ve got a lot of great things
ahead for ISMTE.
In this issue, you’ll hear from
our President, Kristie Overstreet,
as she lays out the plans and vision
for her term. ISMTE membership has voted and elected both
new and returning members to the
Board for 2014. If you are interested in getting more involved with
the ISMTE, any Board member
will be delighted to hear from you.
Jeffrey Beall shares his concerns about the increased number of predatory publishers in
Open Access. In an article by
Anne Brownsey, read about one
society’s challenge to redesign
their member magazine. Have
you heard the term “altmetrics?”
Catherine Chimes explains how
Altmetrics can be an alternative
way to measure journal impact.
Looking for a way to store
and organize your notes, text,
Editorial Office News

and images in one place? In this
month’s “Taming Technology” article, Lindsey Brounstein explains
the basics of Microsoft’s OneNote
and demonstrates the software’s
capabilities. Kimberly Rosenfield
introduces a new section “The
Winding Path: How I Ended up
in Academic Publishing” all about
how we found ourselves involved
in scholarly publishing.
Some new faces have joined the
EON Editorial Team including
Associate Editor, Nijsje Dorman,
Section Editor, Kimberly Rosenfield, and our Editorial Intern,
Anna Demmitt. Welcome back to
our returning Editors—Lindsey
Brounstein, Ira Salkin, and Editorial Advisor, Deborah Bowman.
We want to hear from you! Have
an idea for an article or topic you’d
like to see in EON? Are you interested in writing about an area of
expertise? I am eager to hear your
ideas and suggestions, so please
contact me at mmcdevitt@asge.
org. Happy reading!
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ISMTE and You
By Kristen Overstreet
President, ISMTE
Kristen@origineditorial.com

Did you know that ISMTE exists just for you?
It does, and I love that. I love that it exists for
me as a Managing Editor and that there is a place
with resources I need and people who get me. I
also love that it’s bigger than that—that it serves
other roles who work in Editorial Offices; it serves
Technical Editors, and it serves our partners in the
industry. It’s not perfect, of course. Perhaps I’ve
never had every one of my questions answered or
found every resource I needed, but I know the opportunity exists. ISMTE is growing and evolving
and blossoming, and it’s able to do that because
of you. You bring unique knowledge and perspective, and by voicing your needs, you create the
opportunity for new resources to be created and
others’ needs to be served. Please don’t stop sharing either your knowledge or your suggestions.
I am honored to have the opportunity to serve
this society as president for the next two years.
The time will pass quickly and I hope in that time
to build upon the great work of my predecessors,
Jason Roberts, Elizabeth Blalock, and Glenn Collins, and leave this society better and stronger than
I found it. In my vision, this will require focus in
four areas: committees, marketing, partnerships,
and value.
Committees
Our committees do the work of the society. The
meetings you attend, the resources you have access to, the great content of the newsletter you
read, etc., all come from committees of 1-10
people, often including members of the Board
of Directors. Those who serve on the committees have the opportunity to share their expertise
and ideas, and create something for the benefit of
others. Is it hard work? Yes, often it is, but you
get out what you put in. We are always looking
for people to serve on committees. Let me know
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if you are interested and/or watch the website for
opportunities.
“Intellectual ‘work’ is misnamed; it is a pleasure, a
dissipation, and is its own highest reward.” -Mark
Twain in The Connecticut Yankee
Marketing
We need to do a better job of sharing what we have
to offer. I often meet people at industry meetings
who have never heard of ISMTE. How can this
be? I know many of you out there are telling others about the society, but we need the society to
do a better job of marketing itself. Our meetings
are excellent. The content published in EON is
amazing, thanks to Deborah Bowman for 2012
and 2013, and now going forward to Meghan
McDevitt. Our professional development committee (previously resources and training) continues
to provide the resources we need to do our jobs
every day in one easy-to-access location. We need
to share all of this with more people. One new
initiative will be a weekly email from the society,
marketing what we have to share. Feel free to forward this email on to others you know who may
be interested. Another initiative will be a relaunch
of the website this spring by our new management
company, Apex (www.ApexManage.com).
Partnerships
One area of recent growth has been our partnerships with others in the industry. We need to keep
this growing. Take a look at the last page of EON
or the “Supporters” page on the current website
and see the partnerships we are benefitting from
and those who are benefitting from partnership
with us. Working together, we can provide more
resources and reach more people. For example, as
of this writing, plans are being finalized to partner
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with COPE (http://publicationethics.org) for
workshops/seminars at both the North American
and European meetings in 2014, following our
partnership with EASE (European Association of
Science Editors) for our European meeting last fall.
Value
You pay to belong to this society and you deserve
value in return. Besides what is listed above (two
annual meetings, EON, professional development
resources, access to other organizations), you also
benefit from social media posts (Facebook and
LinkedIn), discussion forums (Members only and
LinkedIn), and building relationships with others
in the industry whom you meet through ISMTE.
The best way to find value in your membership
is to be actively involved: join a committee, submit a poster abstract, agree to speak at a meeting,

participate in the discussion forms and on social
media, and let the members of the Board know
what is great about ISMTE and what needs improvement. In these ways, you can give back to
the society and also increase the value that ISMTE
has to offer.
ISMTE is a place to call your own. It is the society
that serves your specific needs. It exists for you.
I know it exists for me. I have gotten the same
feeling at each ISMTE conference I have attended and I look forward to feeling it again this year
and the next. It starts before I even walk into the
meeting room. It starts when I hear the buzz of
passionate, excited voices in the hallways. It starts
when I see all of you and realize I am with my
people.

The ISMTE membership elected new directors and officers to the Board for 2014. Congratulations
to both newly elected and returning members!

ISMTE Leadership
Position

Name

Term

President
President-Elect
Vice President
Immediate Past Pres.
(non-voting)
Treasurer
Secretary
Director
Director
Director
Director
Director
Director
Board Mentor
(ad hoc; non-voting)

Kristie Overstreet
Michael Willis
Julie Nash

2014-2015
2014-2015
2014-2015

Glenn Collins
Sally Gainsbury
Deborah Bowman
Jan Higgins
Alice Ellingham
Meg Wiest
Sarah Bidgood
Sherryl Sundell
Meghan McDevitt

2014-2015
2013-2015
2014-2016
2013-2016
2014-2017
2014-2015
2013-2015
2014-2017 (2nd term)
2014-2015

Elizabeth Blalock

2014-2015
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Unintended Consequences: The Rise of Predatory
Publishers and the Future of Scholarly Publishing
By Jeffrey Beall, MA, MSLS, Associate Professor,
Scholarly Initiatives Librarian
Auraria Library, University of Colorado Denver

Predatory publishers—those that abuse the gold
(author-pays) model of scholarly Open Access
publishing—have been quickly increasing in number since 2009. I publish a list of predatory publishers on my blog Scholarly Open Access (http://
scholarlyoa.com), and I’ve documented a steady
increase in the number of questionable publishers
and journals. For example, my 2014 list of predatory publishers contains 477 entries, compared to
225 in 2013. A second list, of questionable standalone journals, now includes 303 publications;
last year’s list had 126. Never before has scholarly
communication been faced with such a high proportion of low-quality, counterfeit, and corrupt
publishers.
The Damage They Do
Predatory publishers damage scholarly communication in many ways. First, they often perform a
cursory peer review, or they don’t perform one at
all, pretending that they do. This practice means
that a lot of methodologically, statistically, and
scientifically unsound papers are being published.
And because these papers are published in what
appear to be scholarly journals, they bear the imprimatur of science. This can lead to their being
cited in later studies, and, through the cumulative
nature of research, poisoning future work.
Second, predatory publishers target those most
unfamiliar with the scholarly communication ecosystem—junior faculty, postdocs, and graduate
students. Famous for their incessant spam emails,
predatory publishers and stand-alone predatory
journals target young researchers with personalized messages praising an earlier work and requesting another. These publishers are very good
at appearing legitimate. They expertly mimic es-
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tablished publishers’ websites, choose journal
names that encourage confusion with legitimate
publications, and list the names of respected scientists on their editorial boards (often without their
knowledge or permission).
Also, predatory publishers are contributing to
what appears to be a marked increase in the occurrence of research misconduct. This includes
plagiarism and self-plagiarism, image and data
manipulation, and ghost and gift authorship. Finally, I find that most predatory publishers lack
an understanding of the need for digital preservation. They seem to think that hosting all their
content on a single server without any backups
is sufficient. I have already seen lots of predatory
Open Access content disappear, and I expect to
see a lot more vanish after this first wave of predatory publishers runs its course.
These weaknesses of predatory publishers stand
in stark contrast with the substantial value that
professional publishers add to research. A video
posted on the Society for Scholarly Publishing’s
YouTubeTM page in 20131 asks several publishing
executives the questions, “What value do scholarly publishers add to society? What are they good
for?” A very good answer came from Jennifer
Pesanelli, Director of Publications, Federation of
American Societies for Experimental Biology, who
said, “…we let the researchers, the scholars, the
scientists do their work while we take care of the
business of disseminating the information.” Another fine, summative answer came from David
Smith, Head of Product Solutions, The Institu1

Society for Scholarly Publishing. What value do
scholarly publishers add to society? What are they
good for? 2013. Retrieved from: http://www.
youtube.com/watch?v=oBpzoFjyNig
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tion of Engineering and Technology, who stated,
“We aggregate, we validate, we curate, we disseminate. We’re in the business of making information actionable.”
While there are some Open Access publishers
that follow industry standards and are not predatory, the increasing number of predatory publishers is staining the Open Access movement overall. The movement has facilitated and enabled
the creation of thousands of low-quality scholarly
journals, many of which are corrupt and actively
aim to scam honest researchers.
Technological Transitions
In recent decades in my field, library science, we
have lived through a giant technological and social
change that greatly affected the operations of almost every library in the world: the transition from
card catalogs to online catalogs. In this case, the
change didn’t have a social movement behind it;
it was organic. There was no one shouting “Card
catalogs must go,” or “Online catalogs now!” The
change occurred naturally, with everyone seeing
the advantages of online catalogs, implementing
them as soon as they could. Card catalogs were
gradually phased out, the newer technology and
practices replacing the old.
The Open Access movement hasn’t progressed
this way. The movement first gained prominence
in 2002 with the signing of the Budapest Open
Access Initiative, making it about 13 years old,
which is long for a social movement in the Internet age. Currently much disagreement exists
among the stakeholders in scholarly communication regarding the future of scholarly publishing.
Those who closely follow the conversation are accustomed to the combative and factious conversations that occur on email lists and blogs covering
Open Access and traditional publishing.
Open Access advocates would argue that the
reasons why open access hasn’t been universally
embraced lie in the vested interests of the traditional publishers in maintaining the status quo, but
perhaps the resistance indicates that the simple arguments used to promote Open Access don’t tell
the whole story, or that the new technology and
practices aren’t really better than the old. It’s still
unclear whether scholarly Open Access publishing
FEBRUARY 2014

is actually more cost-effective and sustainable than
subscription-based publishing. Some Open Access
publishers have lowered peer-review standards,
implementing a “light peer review” that merely
judges whether an article is correct scientifically
but does not evaluate novelty or importance,
and publishing vast numbers of these minimally
reviewed and unrelated papers in generic megajournals. The emergence of predatory publishers has marred scholarly communication, leaving
many researchers unsure whether they should
submit to Open Access journals at all. The movement’s motto seems to have been, “open access at
any cost.” Unfortunately, the costs to the scholarly community brought about by predatory and
other low-quality publishers have been high.
A shift from subscription journals, which are
reader centric, to journals using the gold (author
pays) model is a major one with broad implications. Subscription journals have strong incentive
to keep the readers pleased, or they will lose their
subscriptions. Subscription journals that do not
serve their readers well typically face the eventual
shutdown of the journal. This is a communitydriven quality control mechanism that is lost in
the Open Access world. Gold Open Access journals are author centric and need to appeal to authors (and the income they provide) to sustain
themselves. In scholarly publishing there are far
more readers than there are authors. The predatory journals represent the extreme case of author
centricity—they exist solely to fulfill the authors’
need to get articles published, without any concern for the consumers of scholarly research, the
readers. There are hundreds of predatory journals
publishing research of meager quality that no one,
apart from web crawlers, will likely ever read.
Modern civilization depends on sound science
to progress effectively. Policy makers rely on research to create and implement sound public policy. Lawyers use research findings in litigating cases.
Health care providers translate recent medical research into clinical practice. All these occupations,
and many more, rely on high-quality research to
perform effectively. The advent of predatory publishers has polluted the body of research with many
articles and findings that have not passed through
an adequate peer review. It is now easier than ever

Editorial Office News

www.ismte.org

5

Unintended Consequences

ARTICLE

for someone with nonscientific ideas about global
warming, the etiology of autism, and the nature
of dark matter and dark energy to get their ideas
published in a scholarly journal.
The future of scholarly publishing will likely
include a variety of distribution models, including both Open Access and subscription journals.
But I think journal quality will emerge as the singular criterion for evaluating journals. Whether
a journal is open or toll access won’t matter as
much as whether the journal adds value to the research it publishes. The Open Access movement
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seems to mistakenly equate scholarly publishing
with merely posting scholarly manuscripts online,
largely overlooking the crucial role that publishers play in making research discoverable, and ignoring the value that publishers add to research
information through curation, copyediting, ethics
management, and the like. In fact, the high-quality work that Editors-in-Chief, Managing Editors,
and Technical Editors provide has never been so
important. It is their work that will attract the best
papers and distinguish the quality journals from
the predatory ones.

www.ismte.org
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Society Member Magazine Redesign for the Digital
Age…Without Forgetting Print
By Anne Brownsey
Assistant Director of Public Relations and Member Communications
American Society for Gastrointestinal Endoscopy

Starting in 2009, the American Society for Gastrointestinal Endoscopy (ASGE) has made sweeping changes to its publications strategy, driven by
economic factors, new technology, and, above all,
finding the best approach to delivering the content members want. What follows is a case study
on the evolution of one of the Society’s communications vehicles.

surprisingly, many members wanted the magazine
to return to print, while still having access to the
digital option.
Given these issues, ASGE embarked on a revised publications strategy in 2012 that included
the redesign of its member magazine to a truly
digital format as well as a return to offering members the magazine in print.

Backstory
Since the early 2000s, the bimonthly member
magazine, ASGE News, provided members with
clinical and practice management information
along with news on advocacy, educational programming, and member benefits. In 2009, due to
a loss of funding to print and mail the publication,
the Society had to quickly make the publication
into a digital magazine while working with the
same design constraints.
The following year, ASGE moved from a bulky
PDF download—in which it was difficult to navigate to and from website links—to an actual digital magazine. With some minor adjustments to
the PDF design on ASGE’s end, the new vendor
was able to give the Society a digital publication
that was faster to navigate and offered the ability to archive articles for reference, along with options for viewing on mobile devices.
Several challenges remained. First was the actual look of ASGE News. The magazine’s design
hadn’t been updated in nearly a decade, and it was
still the same “vertical” PDF trying to operate
in the new, “horizontal” format that readers had
come to expect when viewing a digital publication.
In addition, given all the email inundating their
in-boxes, members said that they wanted briefer
communication vehicles, in general. Somewhat

Strategy
Working with the Society’s Publications Committee, a group of volunteer physician members, staff
outlined a new plan for effectively communicating with ASGE members that revised the design,
content, and frequency of each member publication. We assessed all the communications vehicles
to see how they could better serve our members
without increasing costs or overloading members
with emails while continuing to deliver timely, informative, and easy-to-read content that members
like and need.
Staff and physician volunteers drafted a content
outline for the magazine, creating a smaller, more
focused publication. Taking into consideration
the top articles read in the previous magazine and
the types of content of most concern for members, a list of six main sections was created for the
future vendor to design the magazine around.
This included the President’s Message, a clinical Q&A called “Ask the Expert,” other sections
that would highlight ASGE courses, programs,
research grants, and advocacy news, and a new
section, “ASGE at Work for You,” demonstrating
how the Society is working to benefit members.
ASGE issued a request for proposals to design
firms and outlined the problems with the existing
publication to address in a revised format. Challenges with the digital format were page jumps as
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well as zooming and scrolling issues. The magazine’s design was difficult to read and not ideally
customized for smartphones or tablets. We wanted
to redesign the publication and its technological
platforms to make it reader friendly for multiple
formats: desktop, smartphone, and tablet. Page
count, article length, and frequency also had to be
considered in the updated digital design. A separate design for print needed to be addressed too.
At the end of 2012, ASGE had chosen a vendor, Nxtbook Media, to handle the redesign of
the publication. Nxtbook outlined a proposal that
addressed all of our challenges, while offering new
elements and design options that would make the
digital magazine user friendly and interactive, with
an appealing new design for both print and digital
formats.
Nxtbook also created a new color scheme,
playing off the main color in ASGE’s logo, and
employed an effective use of color blocks behind
text to delineate articles, sections, pull quotes, and
more in both the print and digital editions.
Execution
As a result, in 2013, we retired ASGE News and
launched a new member magazine, ASGE Connection. The name reflects the publication’s new
purpose: to build community and keep members
connected to their Society and to deliver valuable
content that leverages the wisdom and knowledge gained from our top experts. The magazine
is now published on a quarterly basis rather than
bimonthly, with a reduced page count (from an
average of 36 pages to 12 pages for print and 18
pages for digital—larger fonts and design elements
for readability mean more pages for the same content in the digital version).
The return to print respected long-time members who enjoyed having a hard copy of the publication, while acknowledging a younger generation of members who are more e-pub oriented. In
addition, there was a loss in advertising revenues
when the print edition ceased; since print ads generate more revenue, it was decided to publish the
magazine in both digital and print formats.
By reducing frequency and size, the printing
costs were affordable. We were also able to expand the publication’s return on investment, since
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distributing in print and electronic formats will
increase its reach and add a tangible benefit—a
printed issue in hand to demonstrate the value of
member dues.
Details
The digital magazine offers the most opportunity
for creative design and interactive elements. While
the content and color scheme are the same as the
print edition, the digital version allows for the use
of more graphics and photos. It includes, for the
first time, space for a large cover photo and short
table of contents featuring highlighted articles
that readers can click on to jump to the article.
For readability purposes and to accommodate a
larger font, the digital edition is 18 pages. Navigation is vastly improved, with toolbar buttons at
the top for the table of contents page, to save or
print the magazine, to zoom in or out, and a help
button. Readers can easily go to the next page of
the magazine by clicking an arrow in the bottom
right corner of each page. Links within articles allow readers to access additional information on a
topic or to email a staff member for more information. The links for additional information help
to reduce article length by referring readers to
content housed on our website. Also, to increase
visibility of the links within the articles, Nxtbook
added a pulsating effect on each link. Text that is
a link pulses in a block of yellow color three times
as soon as a reader turns to each page.
The most popular article in the magazine is
“Ask the Expert,” a clinical Q&A with questions
submitted from members and answers from an
ASGE topic expert physician. Within the digital
edition, Nxtbook created a design feature that
includes each question and then readers click on
the letter “A” to see the answer pop up on their
screen in a new window. As this section is typically
very lengthy, the pop-up design solution enables
this section to keep to just two pages.
Another exciting feature of the digital magazine
is the incorporation of video into the articles. Endoscopy employs the use of video images, so this
is a particularly nice feature to include in the magazine for our members. The “Ask the Expert” column now regularly features a clinical video from
the author related to the Q&A content.

www.ismte.org
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The inaugural issue of the digital magazine featured a video tour by the Society’s president of
ASGE’s new state-of-the-art training facility and
world headquarters to give members a preview of
the building before it officially opened.
As before, the magazine is led by a Managing
Editor and articles are contributed by both physician members and ASGE staff. The magazine staff
team meets quarterly to review the editorial calendar. The Managing Editor compiles all articles,
graphics, photos, and video elements, which are
then uploaded to Nxtbook to design the digital
and print versions. Nxtbook provides the design
files for the print edition to us to share with a separate printing vendor.
The digital magazine is distributed via email by
ASGE to both domestic and international members. The print edition is sent to domestic members only. International mailing is costly and often
magazines become lost or arrive months late when
mailing overseas. The digital magazine is now

easily read on smartphones, tablets, and desktop
computers, and each issue is housed on the ASGE
website.
Results
The first issue of the redesigned magazine was distributed in April 2013. Feedback from our physician leadership and members has been very positive. Readership is steadily increasing and we have
been working with Nxtbook to tweak elements of
the design as well as edit our email format for the
digital version to increase open rates and views.
We’ve been very happy with the redesigned look
of both the print and digital editions, and are particularly excited to offer our members a digital
magazine that is easy to read wherever they may
be and that incorporates appealing photos, graphics, and videos, while giving them the content that
they need and want to help them in their practice,
with their patients, and with their careers.

ISMTE welcomes new management staff
Kimberly LaBounty now serves as the ISMTE Executive Director with the help of the staff at Apex
Management & Special Events, Inc.
Please note the NEW phone number, email, and mailing address.
310 W. Lake Street, Suite 111
Elmhurst, IL 60126 USA
ISMTE new phone number:
(+1) 630.433.4513
ISMTE new email address:
info@ismte.org
ISMTE’s other email address, ismteoffice@gmail.com, will continue to be monitored.
Many thanks to Leslie for all she has done for us over the past four years. Leslie is moving on to
other opportunities and can be reached via LinkedIn.
FEBRUARY 2014
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Altmetrics: What, Where, Why?
By Catherine Chimes
Head of Marketing & Customer Relations
Altmetric LLP

Altmetrics have become a buzzword in scholarly
publishing in the last year. But just what is all the
fuss about?
As evaluation criteria expand and budgets tighten, authors, publishers, universities, and research
bodies are increasingly looking for additional ways
to demonstrate the reach and value of their work.
Traditional measures of scholarly impact, such as
the Impact Factor, tend to focus only at the journal level—with little insight into how the individual articles within a publication perform.

Recent advancements have therefore seen new
measures emerge, which take a more granular
view of the dissemination of articles and associated research content. Commonly referred to as
altmetrics, or alternative metrics, these new forms
of measurement look beyond citation and publisher usage counts, with a focus on online “mentions” of a research work. By collating data from
sources, such as social media, blogs, news outlets,
bookmarking sites, peer-review forums, and policy
documents, we are now able to see a much richer
picture of the true reach of the scholarly content.
Numerous tools developed by a handful of
small start-up companies, such as Altmetric, Impact Story, and Plum Analytics, are now available
for easily tracking and monitoring these channels,
which are becoming increasingly important in the
wider scholarly context. As a way of determining reach beyond (but complementary to) the
more traditional journal-level citation tracking,
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altmetrics data add a new layer of insight into the
attention and societal impact the work has garnered.
By providing both qualitative and quantitative
data for a paper, altmetrics can help authors and
publishers explore, understand, and engage in
the conversations that are going on around the
research. This can be used to help influence future publications or research, and serves to further
stimulate the academic discussion.

The task of tracking and reporting on an individual scholarly article is not without obstacles—
not least the need to disambiguate between different versions of a single piece of work. In order to
do this with accuracy, at Altmetric, data collation
is based on a scholarly identifier unique to each
article—for example, the DOI or PubMed ID,
will remain the same whether hosted on the publisher’s site or within an institutional repository.
Using this method, we have so far collated over
7.5 million mentions, relating to over 1.8 million
articles.
Some papers, of course, will receive much more
attention than others. It is important to remember
that altmetrics provide an indication of reach, not
quality. An article or topic that has broad appeal,
particularly amongst the general public, is likely to

www.ismte.org
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see a high number of mentions. Examples of this
include the 2013 papers, “Overview of Active Cesium Contamination of Freshwater Fish in Fukushima
and Eastern Japan,” which has received over 9,000
mentions on Twitter alone, and “Primary Prevention of Cardiovascular Disease with a Mediterranean Diet,” which has so far been featured by over
40 mainstream news outlets.
The scope for development within altmetrics is
huge. To their favour, altmetrics provide a rapid
and timely method of assessing the attention a paper receives—particularly in comparison to citations, which take years to accumulate. By examining the raw data behind each mention, it is often
possible to identify online communities who have
taken an interest in the research but may otherwise have gone undetected. This is particularly
relevant in cases where the work has a more practical application—for example a paper which is
little cited may in fact have had a large amount of
impact on policy and amongst the clinical nursing
community, who do not tend to actively publish
research.
One must consider that the measures used today may not be considered important in five years’
time, and there are some contentious issues in the
space that must be continually addressed. At present, the collation of altmetrics is not standardized,
although there is much crossover between providers and sources. It is yet to be determined which
outlets are the most important to track—and the
results need to be carefully reviewed in context
before any meaningful conclusions can be drawn.
Technical limitations, such as the inability to track
multimedia (audio and video) unless the unique
identifier can be found in the metadata, are a recognized issue. Others have raised concerns that
the altmetrics data could be easily gamed—fake
Twitter accounts abound, and large numbers of
mentions are simple to create. At Altmetric we
have developed a spam-watching algorithm in
order to combat this—any suspect mentions are
flagged and investigated by our team.
Recent workshops run by the Public Library
of Science (PLOS) and the National Information
Standards Organisation (NISO) have taken steps

FEBRUARY 2014

to begin to achieve a consensus on the standardization for altmetrics data as a whole, and to discuss and form a roadmap for how the field is likely
to progress.
2013 saw a number of prominent titles move to
integrate altmetrics data on their journal platforms
using the Altmetric application programming interface (API). Publishers including Nature Publishing Group, the BMJ Group, the Royal Society
of Chemistry, and BioMed Central all now display
altmetrics for each article—usually accessible via
a “metrics” tab or similar. The team at Nature
Climate Change is currently trialing a “trending
articles” list, based on the online activity on any
given day. The data are pulled on request directly
from our servers, and provide users with an instant compilation of the mentions for each paper.
Displaying the data in this way allows authors and
readers to easily gauge the attention their work is
receiving, and can help the publishing teams identify which are their most talked-about articles, or
where there is perhaps a need to increase their
communication efforts.
Additionally, we offer the opportunity to explore the altmetrics data for any article via a
web application: the Altmetric Explorer. Users
can search by DOI, keyword, journal, publisher,
funder, and a number of other filters. This enables
a comparison between related journals, which can
give a unique insight into how your publication is
performing.
Overall, the reception for altmetrics has so far
been mostly positive. Uptake amongst publishers has been high, and already we see examples
of researchers incorporating the data surrounding
their articles into their CVs. As the amount of online discussion around published research continues to grow, altmetrics as a tool for identifying and
exploring the broader impact of scholarly work are
anticipated to continue to gain in significance.
If you are interested in finding out more or integrating altmetrics data for your journal, you can
visit www.altmetric.com, or email info@altmetric.
com. We’re always open to new opportunities and
would be happy to work with you to develop a
custom solution.
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OneNote 2010 Part 1: Basics
By Lindsey Brounstein
Managing Editor and Software Training Manager
American Gastroenterological Association
lbrounstein@gastro.org

What Is OneNote?
Microsoft OneNote is an all-purpose note-taking
tool designed to store everything related to a topic (text, web clips, links, multimedia files) in one
location. OneNote can help organize just about
any aspect of life—from work projects, to home
improvement plans, to your favorite recipes, or
books you keep meaning to read.
OneNote is a very powerful program, which
can be intimidating and even overwhelming at
first glance. In part one of this Taming Technology series, we’ll explore the very basics of OneNote 2010 to get you started before jumping
into additional features and tips and tricks in part
two.
OneNote Structure
OneNote files are organized in the following format:
1. Notebooks
° A notebook is the overarching category for the types of notes being
stored together.
° Examples of notebook categories
can be “Work” or “Home.”
2. Section
° Did you ever have one of those
5-subject notebooks in school, or
a big three-ring binder that had
dividers for each subject you were
taking? Those are OneNote Sections.
° In a Notebook labeled “Home,”
some possible sections could be
“Projects,” “Budget,” or “Recipes,” while a Notebook for “Work”
might have sections for each project that you’re working on.
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3. Page
°
°
°

Within each section are pages.
Pages are where you keep the actual information you want to store.
In our “Home” notebook example, the pages under the “Recipes”
section would be the actual recipes
typed out or linked from the web.

OneNote Basics
• You can type anywhere on a page simply by
clicking. This creates a text box that can be
adjusted by clicking and dragging any of the
edges, or moved by clicking and dragging the
gray bar across the top.
• Formatting is available similar to Microsoft
Word.
What Can I Save in OneNote?

The short answer is everything! You can:
•
•
•
•
•
•
•

Add text with formatting
Add drawings and tables
Paste photos
Copy and paste part of a web site
Insert multimedia clips
Print to OneNote (instead of a printer or PDF)
Send emails, calendar events, and tasks from
Outlook
• Use screen capture to take a partial screenshot
and paste it to OneNote
Setting Up OneNote
When you open OneNote for the first time, you’ll
need to create a Notebook.
1. Go to File New
2. OneNote will ask you where you want to
save your new Notebook:
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°
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“Store Notebook On: Web” will
save your Notebook to Microsoft
SkyDrive (more about this below),
which allows you to access your
Notebook from any computer with
OneNote, or from any browser,
even if OneNote isn’t installed
on the computer. You can even
download the SkyDrive app on
your mobile device to access your
Notebook on the go. It also allows
you to share your Notebook with
others on the web if you choose.
This is the most versatile option for
storing your Notebook, especially
if you plan to access it from multiple locations.
“Store Notebook on: Network”
will allow you to save your Notebook to a network location, such
as a shared drive or your organization’s SharePoint site.
“Store Notebook on: My Computer” will save your Notebook to
a local location on your computer.
This is the most limited way to save
your Notebook, as it will not be
accessible from any locations other
than the one computer.

3. If you select “Store Notebook on: Web,”
which is my personal recommendation,
you’ll be given the option to sign up for
Microsoft SkyDrive.
° Microsoft SkyDrive is a cloudbased storage location for the Microsoft Office Suite. You do not
need to have a license to the Office suite to use SkyDrive. SkyDrive
provides 7GB of storage, as well as
access to their browser-based Office
software for free. This means that
even if you don’t have OneNote at
home, you can still access and edit
your OneNote Notebooks.
° Remember, Microsoft SkyDrive is
a free service offered by Microsoft,
which means if there were some
issue with SkyDrive and your files
were lost or corrupted, Microsoft
would be under no obligation to
help retrieve your information.
That said, regularly backing up
your Notebook on your computer
is a quick and easy way to avoid any
unpleasant issues. You can set your
OneNote Notebook to automatically create a backup file and see
the backup location by going to
File—Options–Save and Backup.
4. Once you’ve selected a location to save
your Notebook, you need to give it a
name.
5. Click Create Notebook.
6. When the notebook is created, you may
see the following pop-up:
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This is just giving you the option to share your
Notebook with others. You can simply click “No,
Thanks,” to continue without sharing. Unless you
saved your Notebook to a network location, your
Notebook will only be accessible by you unless
you change the Sharing options later.
7. Your new Notebook will look like this:

The Insert tab allows you to place different types
of information into your notebook. Everything
from tables and screen clippings to audio and
video recording is available.

The name of the Notebook appears on the left.
The section tab appears across the top. The pages
appear along the right side. You can rename a
Notebook or Section at any time by right-clicking
and selecting “Rename.” You can rename a Page
by typing in the rectangular bubble at the top of
the page.

The OneNote Ribbon
OneNote has a ribbon across the top of the page,
just like any other Microsoft application. By default, the ribbon is collapsed, but clicking on each
tab shows the expanded ribbon with the options
that fall within each category. Double-clicking on
a tab keeps the ribbon expanded.

Home Tab
The Home tab on the ribbon provides basic formatting features, as well as Tags, which allow you
the option of including small icons with your
notes (checkboxes for to-do lists, highlighting,
an exclamation point or light bulb to highlight an
idea, etc.).
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Insert Tab

Share Tab
The Share tab lets you share your notebook with
others so you can collaborate together. It also lets
you view page versions, or find edits made by other authors. This is also where you access the notebook’s recycle bin for any items you’ve deleted.

Draw Tab

The Draw tab lets you use a touch screen, stylus,
or mouse to draw or add handwritten notes to
your notebook.

Review Tab
The Review tab contains basic review functions
such as spell check. It also allows you to take
Linked Notes, which docks OneNote to one side
of the screen. Any notes made in that window are
automatically linked to the web page or document
you’re viewing at the time.
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View Tab
The View tab lets you change how your notebook
is displayed. You can dock the notebook to your
desktop, change the background color of the pages, pin the notebook on top of other windows, or
had rule lines and grids to the background.

notebook to Microsoft Word or PDF, or email a
OneNote as an attachment, a PDF, or inserted
into the body of an email.
Note that with OneNote, unlike other Microsoft applications, there is no “Save” button. OneNote automatically syncs changes as you make
them, so you will always have the most updated
version of your Notebook, no matter what.
Coming Up in Part Two

File Tab
The File tab contains all the standard items you’d
find in any Office program, including Save As and
Print. You can also change the settings on a given
notebook, share a private notebook with others
for collaboration, save a page, section, or whole

In the next Taming Technology column,
we’ll explore some of the special features that
OneNote has to offer and how these features
can be utilized to improve organization and
productivity.

Submit a Poster
For the 2014 ISMTE Conference
Poster Proposals Due March 1!
Accepted posters will be shared at this year’s annual meetings.
Visit www.ismte.org for more details and to submit your proposal online.
Questions? Contact Erin Dubnansky at edubnansky@gastro.org.
FEBRUARY 2014
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The Winding Path: How I Ended up in Academic
Publishing
By Kimberly Rosenfield
Manuscript Coordinator
The Endocrine Society

Maybe it’s a product of living in Washington, DC,
where the most important question you can ask
a person is “What do you do?” but I’ve learned
a lot about what other people do for a living.
I’ve found that people travel the most fascinating
paths to end up at the job they love (or love to
hate). Sometimes I meet people who are doing
what they’ve always wanted to do since they were
kids, but those people are admittedly rare; the majority seems to transition into their careers by opportunity, luck, and sometimes, blind chance. My
journey to my career in academic publishing was a
mixture of all the above.
I attended college at Purdue University with
the intention of getting my PhD in history. I always enjoyed reading, writing, and research and it
seemed like a logical step to take, especially since I
was that kid in high school who voluntarily participated in the history fair every year. After undergrad, I entered a PhD program at George Washington University to study US history, specifically,
organized religious participation in political activism. It was during this time that I had my first taste
of the academic publishing world; I submitted a
number of manuscripts to a handful of academic
journals (and was promptly hazed as new authors
are). While I enjoyed the research and writing, the
long-term job prospects were less than palatable;
with nearly five more years of schooling ahead of
me, and an academic job market that would make
any person cry at the lack of opportunity, I decided to leave with an MA in the fall of 2010.
With the economy in a deep recession, I was
desperate for employment; for a few months after
graduating, I bounced around from job to job,
picking up temporary work as an administrative
and education assistant, dog walker, and barista.
Looking back now, these jobs might not have
been life changing, but they were invaluable skill
builders! As an incredibly bookish person, I had to
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learn, and learn fast, how to develop people skills.
In the spring of 2010, I finally landed my first fulltime position as a research analyst for a businessconsulting firm. At first I was thrilled at the opportunity, but it soon became apparent that the
position was not a good fit. Looking back now,
I believe that everyone should have at least one
job they have hated. It helps to realize what is and
isn’t for you, and you’ll never know if you aren’t
good at something until you try it out. I realized
consulting work is not my forte; to be honest, neither is making coffee, but I did learn to make a
mean espresso.
A year into my position as a research consultant, I took a terrifying leap and quit my job to
reassess my career goals, but only a week passed
before I interviewed with The Endocrine Society
and was offered my current position as an Editor
and Manuscript Coordinator. Immediately things
clicked in a way they hadn’t before. Academic
publishing was familiar, as was peer review and
working with PhDs (only this time, it was science,
not history!) and the more I explored the opportunities for growth, the more involved I became.
A year into my position, I joined ISMTE and the
Society for Scholarly Publishing, and have been an
active participant ever since.
If you asked me three years ago to predict my
future career, I would have gotten it all wrong,
and I think that is ultimately a good thing. For
those of you who are newcomers to the world of
academic publishing, realize this: some of us have
purposefully led ourselves to the industry. Others,
like myself, came here through the most fortuitous of accidents and winding of paths to get to
where we are now.
Do you have a story to share about how your career
developed along a winding path? Share it with us
by emailing Section Editor Kimberly Rosenfield at
rosenfield.k@gmail.com.
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EVENTS

Calendar of Events

Thank You

Introduction to Journals Publication
March 12, 2014
London, England
http://www.alpsp.org

to our Corporate Sponsors!
Platinum Level

aMWa Mid-atlantic chapter conference
March 14, 2014
Gaithersburg, Maryland
http://www.amwa.org

Wiley-Blackwell

COPE European Seminar 2014
March 14, 2014
Brussels, Belgium
http://publicationethics.org/events

Silver Level

Masters in Publishing: An interactive online
discussion with Howard Ratner
March 27, 2014
Webinar
http://www.alpsp.org

ACS Publications
Origin
Wolters Kluwer

Emerging Trends in Scholarly Publishing™
Seminar
April 24, 2014
Washington, D.C.
http://allenpress.com/events/2014seminar

Bronze Level
AIP Publishing, Aries, BMJ Group, Editage,
eJournalPress, j&j editorial, Oxford
University Press, Thomson Reuters

Council of Science Editors Annual Meeting
May 2-5, 2014
San Antonio, Texas
http://www.councilscienceeditors.org
Society for Scholarly Publishing Annual Meeting
May 28-30, 2014
Boston, Massachusetts
http://www.sspnet.org
12th Annual Editorial User Group Meeting
(EMUG)
June 19-20, 2014
Boston, Massachusetts
http://www.editorialmanager.com
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Additional Support: Copyright Clearance
Center, CrossRef, Technica Editorial Services
Interested in supporting ISMTE?
Please visit http://ismte.org/supporters.html
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Editor:

Editorial Office News (EON) is the official newsletter of the International Society of Managing
and Technical Editors (ISMTE) and is published
monthly. The contents and opinions expressed
by the authors do not necessarily represent those
of the Society, the Board of Directors, or EON
Editors, nor does the publication of an article
constitute an endorsement on the part of ISMTE
of the authors’ organizations or companies. Submissions are welcome and can be sent to the Editor at the address below. Submissions may be
edited for style and format without the author’s
permission. Authors must seek permission to reprint any copyrighted material and provide this
permission to the Editor.

Meghan McDevitt
mmcdevitt@asge.org

EON’s content belongs to the members of ISMTE.
Users may view and download EON articles for
personal, non-commercial use. Use beyond that
allowed by the “Fair Use” limitations (sections
107 and 108) of the U.S. Copyright law requires
written permission from the EON editor.

Ethics: Ira Salkin
Irasalkin@aol.com

Associate Editor:
Nijsje Dorman
nijsje@gmail.com
Editorial Advisor:
Deborah Bowman
dbowman@asge.org
Editorial Intern:

Anna Demmitt
anna.demmitt@gmail.com
Section Editors:

Taming Technology: Lindsey Brounstein
lbrounstein@gastro.org
The Winding Path: Kimberly Rosenfield
rosenfield.k@gmail.com

A note on English: ISMTE aims to be a truly international society. English will represent our lingua
franca, but we would like to stress that, in materials published in EON or online, variations in idiomatic usage and spelling should reflect the origins of the author. No one version of English is preferred
over the other.

ISMTE Executive Offce:
310 W. Lake Street, Suite 111Elmhurst, Illinois 60126 USA
ISMTE new phone number:TEL: (+1) 630-433-4513
ISMTE new email address:
info@ismte.org
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